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Practica 8 — Protocolos de acceso al medio: ALOHA y CSMA
“Sesion 2”
1- Objetivos

En esta segunda sesion analizaremos el protocolo CSMA y lo compararemos con ALOHA.
Ademas plantearemos un escenario donde evaluar las prestaciones del protocolo de acceso al medio
de Ethernet en un medio compartido.

2- Avisos generales

Si quieren conservar cualquier fichero entre sesiones guardenlo en una memoria USB, dado que
no se asegura que los ficheros creados o modificados durante una sesion de practicas se mantengan
para la siguiente.

3- ALOHA vs CSMA

OPNET dispone de un tutorial idoneo para el analisis de protocolos de acceso al medio, es el
denominado CSMA/CD. Se puede encontrar en el menu Help de la ventana principal de OPNET, . Al
seleccionar este menu, observaremos que aparecen entre otras opciones “Product Documentation” y
“Tutorials”. En la primera de ellas podremos encontrar informacion relativa al simulador, sobre como
utilizarlo, qué posibilidades ofrece, descriptores de los modelos que ya tiene predefinidos, etc... Se
trata de un pequefio manual al que acudir en momentos de duda. En la segunda, dispondremos de una
serie de tutoriales que permiten observar y llevar a cabo la puesta en practica de algunos de los
aspectos explicados tedricamente en el apartado anterior.

Consulte la “lectura recomendada” en la practica 1, le sera de gran ayuda.

Como documentacion adicional, dispone en la web de la asignatura, de un listado de funciones de
OPNET necesarias para la comprension de determinadas secciones del tutorial. Abra el tutorial desde
la ventana de Opnet, ment Help > Tutorials y comience el tutorial CSMA/CD.

Nota: Realice el tutorial desde la pagina 53-70.
Errata tutorial CSMA/CD(OPNET 10.5): Pagina 55, punto 7 => ;jCorrecto!

La errata radica en la figura de la pagina 54 en relacion a este punto 7.

Analice en detalle cada uno de los pasos indicados por el tutorial con objeto de entender el por
qué de cada uno de ellos. Deberia ser capaz de responder a las siguientes preguntas:

1. (Qué¢ diferencias existen entre lo que se denomina stream wire y statistics wire en el editor de
nodo?

2. (Entre qué estados se aplica la condicion PKT ARVL&& FREE? ;Qué significado tiene?
3. (Qué mejora ha necesitado afiadir a su modelo de transmisor para que soporte CSMA?

4. En el modelo de proceso del transmisor CSMA, ;Qué procedimiento se emplea para verificar
si el canal esta libre? ;En qué estado se encontrard dicho modelo si el canal resulta estar
ocupado?
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Checkpoint 8.4: Explica el disefio del transmisor de CSMA, tanto a nivel de nodo como de
proceso, relacionandolo con el comportamiento que ha de tener por utilizar CSMA como protocolo
de acceso al medio.

Checkpoint 8.5: Represente graficamente el throughput del canal en funcién del tréfico,
considerando todas las simulaciones. ;Cual es la eficiencia de CSMA? ;Coincide con la vista en
teoria? Indique cual es el valor maximo del throughput. Razone su representacion grafica. Realice
una comparativa grafica CSMA vs. ALOHA.

5.

(Cudl de los dos protocolos presenta un mejor resultado en cuanto a eficiencia se refiere?
(Cabia esperar que asi fuera? ;Por qué?

4- Evaluacion de prestaciones del protocolo de acceso al medio de
Ethernet

Ethernet es un estandar de redes de computadoras de area local con acceso al medio por contienda
CSMA/CD o Carrier Sense Multiple Access with Collision Detection. CSMA es una técnica de
acceso a medio compartido que permite a los equipos escuchar el canal antes de transmitir para ver si
otro equipo lo estd haciendo. Existen distintas variantes de este mecanismo, uno de ellos es
CSMA/CD.

CSMA/CD permite detectar no sélo si un equipo esta transmitiendo, sino si ha habido colision, de
manera que en base a esta informacion los equipos puedan variar su comportamiento. Existen tres
variantes:

CSMA no-persistente: en caso de estar ocupado el canal, se espera un tiempo aleatorio y se
vuelve a escuchar, para transmitir inmediatamente si se encuentra libre.

CSMA p-persistente: si el canal estd ocupado se mantiene a la espera de que se libere para
transmitir. En caso de estar libre transmite con una probabilidad p y con (1-p) permanece a la
espera.

CSMA 1-persistente: si el canal se encuentra ocupado se mantiene a la escucha del canal
hasta detectarlo libre y transmitir. Esto hace que puedan ocurrir colisiones siempre que haya
dos estaciones escuchando.

(,Qué protocolo de acceso al medio emplea Ethernet?

4.1 Crear el proyecto

Para crear un proyecto nuevo para la red de Ethernet:

1.
2.

Ejecutar OPNET Modeler 10.5 -- Educational Version => Seleccionar New del ment File.
Seleccionar Project => Clic OK => Nombre del proyecto <arssXY>_Ethernet, y el
escenario Coax => Clic OK.

En el Startup Wizard: En la ventana de diadlogo Initial Topology, asegurarse de Create
Empty Scenario esta seleccionado => Clic Next => Elegir Office de la lista Network Scale
=> Clic Next => Asignar 200 a X Span y mantener Y Span con 100 => Clic Next dos veces
=> Clic OK.
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4. Cerrar la ventana de didlogo Object Palette .
4.2 Crear la Red

Para crear la Red Ethernet coaxial:

Seleccionar Topology => Rapid Configuration. Elegir Bus y Clic OK.

Clic en el boton Select Models en la ventana de didlogo Rapid Configuration. Desde el meni
desplegable Model List elegir ethcoax y Clic OK.

3. En la ventana de dialogo Rapid Configuration, fijar los siguientes 8 valores y pulsar OK.

N —

ﬂ Rapid Configuration: Bus

— Modelz
Mode maodel: Iethu:u:ua:-:_statinn LI Mt |3|:|
Link. model: I eth_coax ll T ap model: I eth_tap ;I
— Placement
iy ~ Head of Buz — — Size :
+ Harizantal Yerhical o
T F : [20 [170
v Topof bus [ Left of bus 2 I— Bl I—
[v Bottorm of bus I~ Eight of bus ¥ IED Tap: |2EI I

Select Models... | ok I LCancel |

4. Para configurar el bus coaxial, Clic-derecho en el enlace horizontal => Seleccionar Advanced
Edit Attributes del menu:

a. Clic en el valor (value) del atributo model => Seleccionar Edit del menu desplegable =>
Elegir el modelo eth_coax_adv.

b. Asignar el valor 0,05 al atributo delay (retardo de propagacion en seg/m).

Asignar 5 al atributo thickness.

d. Clic OK.

e
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-+ (bus_0) Attributes

| Attribute
F - name i
& L model eth_coax_adw -
| creation source R apid Configuration
| creation imestamp 18:26:25 abr 27 2009
) |— creation data
i Fber 0.0
@ F channel count 1
@ | closure model dbu_closure
® | coll model dbu_call
& Feolor RGEOO0
& | condition enabled
# Feost 0.0
B L datarate 10,000,000
P Fdelay 0.05 -
@ Fecc model dhu_ece
& | enor model dbu_error
B | financial cost 0.00
& Lline style zolid
| packet formats ethernet
@ |— propdel model dbu_propdel
) |— syrnbol hione
) |— thickness 5 -
& tedel model dhy_bedel
@ Luserid 0
=
Bedefine F'athl Extended Attrs. | /
[ Apply changes to selected objects v &dvanced
[ Find Newt | o | cancel |

5. Ya se ha creado la red. Compare con la figura siguiente. En caso de que se vea la red muy
pequefia o grande, se debe ajustar el zoom para seguir trabajando.

L E 55!%5555!&%
node_ED node_2 : : nod inoclj 22 nou:l‘_24 | no 28
T R P, SRR SR, SRRSO FE e, SIS, ST > ot IRy AT, ST, SIS, SRS, P D, ST
¥ ¥ b
B e e L HHHHHH
node i hode_3 nqde 5 node_7 node 9  node 11 hods 13 node 15 node 17 i node 19 nhode 21 t‘,ode 23 nhode_ 25 node 27 hode 29

6. Salvar el proyecto.
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4.3 Configurar los nodos de la red

Configuracion del trafico generado por los nodos:

1.

Clic-derecho en cualquiera de los 30 nodos => Select Similar Nodes. Ahora todos los nodos
de la red estan seleccionados.
Clic-derecho en cualquiera de los 30 nodos => Edit Attributes.
Marcar la caja Apply Changes to Selected Objects para que se apliquen los cambios a todos
los nodos.
Expandir el arbol Traffic Generation Parameters:
a. Cambiar el valor ON State Time a exponential(100) => Cambiar el valor de OFF
State Time a exponential(0). (Nota: Los paquetes s6lo se generan en el estado ON.)
Expandir el arbol Packet Generation Arguments:
a. Cambiar el valor del atributo Packet Size a constant(1024).
b. Clic-derecho en el atributo Interarrival Time y elegir Promote Attribute to Higher
Level. Esto nos permite asignar multiples valores al atributo Interarrival Time y por
lo tanto probar las prestaciones de la red bajo diferentes modelos de carga

| (node_10) Attributes

T_l,lpe;l station
|.-5'-.ttril:|ute ;I
F -name - :
& | model ethcoas_station
@'} [=l Traffic Generation Farameters [...]
@ |— Start Time [zeconds] constant [2.0]
@ |—EIN State Time [zeconds] exponential (100] -—
@ |—EIFF State Time [zecondsz] exponential [0] o
@ [=] Packet Generation Arguments [...]
) I Interarrival Time (seconds) promoted -+
el L Packet Size [bytes) constant [1024) -+
@ L& Segmentation Size [bytez] Mo Segmentation
@'} L Stop Time [zeconds] Mewer
@ L Traffic Generation Parameters [0].Packet... promated

[ ]

¥ Apply changes to selected ohjects ——— [T Advanced

[ Einu:INe:-:tl ok | Cancet |
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6. Clic OK para volver al Editor de Proyectos. Si aparece una ventana avisandole que esa
configuracion se afiadird a cada nodo, pulse en Yes.
7. Salvar el proyecto.

4.4 Configurar la simulacién

Para examinar el desempefio de la red bajo cargas diferentes, necesita correr la simulacion varias
veces cambiando la carga en la red. Hay una manera facil de hacer eso. Recuerde que utilizamos el
atributo Interarrival Time (tiempo entre llegadas) para la generacion de paquetes que los nodos
inyectan a la red. Dicho atributo se marco6 como Promote Attribute to Higher Level. Aqui
asignaremos valores diferentes a ese atributo:

1. Clic en el botén Configure/Run Simulation:
2. Asegurese de que esta seleccionada la rama Common => Asignar 15 segundos a Duration.

] Configure/Run DES: arss-Coax

. . : [T Sayve vector and environment files for each minin set
Simulation Set Infa | Mumber of runs in set 1 i
[T Pause betwesr each i i set
— Cammon
—  Glabal Attibutes Duration: |15 |seconds) 7]

— Obiect Attributes o] I'lza Multiple Seed Yalues. . |
—  Erwironment Files

E Outputs Yalues per statistic: |1UU

— Repoits

| Arimation Update interval: I'IUUUUU events

— Statistice Collection
'— Loagaing

+—  Ewecution

+ Runtirne Dizplays

Simulation K.emel: I Based on 'kemel_tvpe' preference j [Preference set to "'development')

I~ Show OPMET Conzole during simulation
[~ Fause foruser nput before closing OFNET Consale whes simulation ends

Comments: ;I
=l

Run Cancel | Apply I Help |

I

3. Clic en la rama Object Attributes de Inputs.

4. Clic en el boton Add. La ventana de didlogo Add Attribute debe aparecer llena con los
atributos generados para todos los nodos de la red (si no viera los atributos en la lista, cierre el
proyecto y redbralo). Necesita afiadir el atributo Interarrival Time para todos los nodos. Para
hacerlo:

a. Clic en el primer atributo de la lista (Office Network.node 0.Traffic Generation
....) => Clic en el boton Wildcard => Clic en node 0 y seleccione asterisco (*) del
menu desplegable => Clic OK.

b. Verd un nuevo atributo conteniendo el asterisco (el segundo de la lista). Para
configurarlo necesita hacer Clic en la celda bajo la columna Add?

c. Laventana de didlogo Add Attribute debe parecerse a la siguiente. Clic OK.
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—+]Add Attribute: scenario

Add? | Urrezolved Attributes ;l
Office Metwark. node_0. Traffic Generation Parameters .
flice Metwork, . Traffic Generation Parameters [0].Pa...
Office Metwark. node_1. Traffic Generation Parameters ..
Office Metwork. node_10.Traffic Generation Parameter. ..

Office Metwork. node_11.Traffic Generation Parameter. ..
Dffice Metwork. node_12. Traffic Generation Parameter...
Office Metwark. node_13. Traffic Generation Parameter. .
Office Metwark. node_14. Traffic Generation Farameter. ..
Office Metwark. node_15. Traffic Generation FParameter. ..
Office Metwark. node_18. Traffic Generation Parameter. ..
Office Metwark. node_17 Traffic Generation Parameter...
Office Metwork. node_18.Traffic Generation Parameter. ..
Office Metwork, node_19.Traffic Generation Parameter. .. ;I

Expand... | 0K I Cancel |

5. Ahora debe ver Office Network.*.Traffic Generation Parameter ... en la lista de atributos
de objetos de simulacion. Clic en el atributo para seleccionarlo => Clic en el boton Set
Multiple Values en la ventana de didlogo.

6. Anadir los siguientes 9 valores. (Nota: Para afiadir el primer valor, doble-Clic en la primera
celda de la columna Value => Teclee “exponential (2)” en la ventana de texto y pulse Enter.
Repetir esto para los 8 wvalores restantes: 1, 0.5, 0.25, 0.1, 0.05, 0.035, 0.03, 0.02. Se
recomienda empleen notacion cientifica ya que el simulador no interpreta bien valores del
tipo 0, (cero coma) 6 0. (cero punto))

ﬂ Attribute: Office Network.™. Traffic Generation Parame... g|

Enter one ar more walues:
Yalue | Limiti Step d
exponential [£]
exponential [1]

exponential [5E-1]
exponential [25E-2]
exponential [(1E-1]
exponential [5E-2]
exponential [35E-3]
exponential [3E-2]
expanential [2E-2]

=
Delete | ok I Cancel Dretailz |

7. Clic OK. Ahora observe en la esquina superior derecha de la ventana de didlogo y asegurese
que Number of runs es 9.
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CEX

Simulation Set Info |

Mumber of runs inzet. 3 -——

E Common

Inputs

Global Attributes
[i]=
Erevirotiment Files
Outputs

Reportz

—  Animation
Statistics Collection
Logging

+—  Execution

+ Fiuntime Dizplays

==

[~ Save vector and environment files for each mn in set

[~ Pause between each un in set

— Object Attributes

a

(|

B exponential [2], exponential [1], exponential [3E-1], exponential [25E -2], esponential [1E-1], &

=

. o

[ Usze default values for unresalved athibutes

Add.. |

Delete

Expand... | SetMuItipIeVaIue3...|

Update I Detailz |

[

Fun

Cancel | Apply I Help |

8. Para cada una de las 9 ejecuciones de la simulacidn, necesitamos que el simulador salve un
valor “scalar” que representa la carga media “average” en la red y otro valor escalar que
representa la utilizacion media (throughput) de la red. Para salvar esos escalares necesitamos
configurar el simulador e indicarle donde debe salvarlos. Clic en la rama Statistics Collection

de Outputs.

9. Asigne <arssXY>_Ethernet_Coax al campo de texto Scalar file.

= Configure/Run DES: arss-Coax

CEX

Simulation Set Info |

Mumber of runs in zet: 9

E Common

|nputs
Global Attributes
Object Attnbutes
Ervironment Files
Outputs

Fieparts
Animation

St
Logging

ﬁ Execution
+ Runtime Dizplays

[~ Sawe wector and environment files for each un in set

[ Pauze between each run in set

— Statiztics Collection

Probe file: arss-Coax

[ Start collecting statistics at ime [sec): I[I

[ Stop collecting statistics at time [sec): |1EIDEI

Wectar file: arsz-Coax

Scalar file: Iarss_Ethemet_Euaﬂ

[~ Clear scalar file befare running simulation set

|

Run

Help

Cancel I Apply

10. Clic en Apply, y salve el proyecto (para ello necesitara pulsar Cancel).
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4.5 Seleccionar estadisticas

Para seleccionar las estadisticas a recoger de la simulacion:

1. Clic-derecho en cualquier punto del area de trabajo (pero no en algun nodo o enlaces) y
seleccione Choose Individual Statistics del ment desplegable => Expanda el arbol Global
Statistics.

a.

b.

Expanda el arbol Traffic Sink => Clic en el check box proximo a Traffic Received
(packets/sec) (asegurese de seleccionar las estadisticas con unidades en packets/sec),
Expanda el arbol Traffic Source => Clic en el check box proximo a Traffic Sent
(packets/sec). Clic OK.

2. Ahora para recoger la media de las estadisticas anteriores como un valor escalar:

a.
b.
C.

Seleccione Choose Statistics (Advanced) del mena Simulation.

Traffic Sent y Traffic Received deben aparecer bajo Global Statistic Probes.
Clic-derecho en Traffic Received => Edit Attributes. Poner el atributo scalar data a
enabled => Poner el atributo scalar type a time average => Comparar con la figura y
Clic OK.

Repetir los pasos anteriores con Traffic Sent .
Seleccione save del menu File en la ventana Probe Model y ciérrela.
Ha vuelto al editor de proyectos Project Editor. Aseglrese de salvar su proyecto.
| (pb0) Attributes M=
| Attribute | Walue ;I
F rname lpl:uEI '
@ | draw style linear
@ Faoup Traffic: Sink
@ |—statisti-: Traffic Receved [packets/sec)
& L odinate label
| vector data enabled
) |— wechar start 0.0
) |— wechar stop irfirity
& Fscalar data enahled -
@ |— gcalar type time average <
B | scalar start 0.0
| scalar stop infiriity
& | capture mode bucket/default total/sum_time
| thieshold comparison dizabled
) |—threshnld walue 0.0
) |—threshnld percent 30
® Litag niane
=
[T Apply changes to selected objects
[ Find Mext | K Cancel |
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4.6 Ejecutar la simulaciéon

Para ejecutar la simulacion:

3
4,

I

|Cn:|nFigure,l'Run Discrete Event Simulation I{DES]I| -

Clic en el boton Configure/Run Simulation
Asegurese de que Duration marca 15 second(s) (no horas) => Clic Run. Dependiendo de la
potencia del ordenador esto puede tardar algunos minutos. En los ordenadores del laboratorio
apenas llevara unos segundos.

Ahora el ordenador estd realizando las 9 ejecuciones, una por cada tasa de generacion de
trafico. Es normal que las ejecuciones tarden cada vez més porque la primera es la de menor
carga y se va incrementando hasta llegar a la Gltima que simula un mayor trafico.

Después de que el simulador termine las nueve ejecuciones, clic Close.

Salve su proyecto.

Si vuelve a repetir la simulacion, OPNET anadird los nuevos resultados a los resultados ya
existentes en el fichero escalar. Para evitar esta circunstancia borre el fichero escalar antes de
arrancar la nueva simulacion.

_Ir al menu File => Seleccione Model Files => Delete Model Files => Seleccione ( .0s):

Output Scalars => Selecione el fichero escalar a borrar;
(<arssXY>_Ethernet_Coax_Scalar) => Confirmar borrado con OK =>Clic Close.

4.7 Ver los resultados

Para ver y analizar los resultados:

1.

2.

4.

Seleccione DES, Results, View Results (Advanced):. Ahora se abre la herramienta de
Analysis Configuration.

Recuerde que los resultados de la simulacion los salvamos en un fichero escalar. Para cargar
ese fichero seleccione Load Output Scalar File del ment File => Seleccione

<arssXY>_ Ethernet-Coax del menu desplegable.

Seleccione Create Scalar Panel del ment Panels => Asignar Traffic Source.Traffic Sent
(packets/sec).average a Horizontal => Asignar Traffic Sink.Traffic Received
(packets/sec).average a Vertical => Clic OK.

i] Select Scalar Panel Data @

Harizomtal: Traffic Source. Traffic Sent [ j
Wertical: Traffic Sink. Traffic Beceiver j
(1] LCancel |

El grafico resultante debe ser similar al de la figura siguiente:
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i] modeler [ZI[EJ@|

Traffic Sink. Traffic Received [packets/zec) average

150

100

4

50

25

I | | |
o 400 200 1.200

Traffic: Source. Traffic Sent [packets/sec] average

Checkpoint 8.6: Explicar el grafico obtenido en la simulacion que muestra la relacion entre
paquetes recibidos (throughput) y enviados (carga). ;Por qué el throughput es bajo cuando la carga es
muy baja o muy alta?
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